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1. Summary

Whether you send one thousand or one million emails a day, each one
should be as unique as the customer that opens it. Bluecore’s platform
makes creating personalized email campaigns easy by reducing the number
of touchpoints in a marketer’s traditional workflow down to one.
Audience segmentation, template creation, and campaign deployment is
reduced to a handful of clicks within a single, easy-to-use interface.
Live analysis on terabytes of behavioral and product data make emails

dynamically unique to every customer— no tech support required.

Bluecore’s customer experience platform is designed to simplify the
process of ingesting terabytes of behavioral data and automatically
acting on precise insights, driving engagement and conversion rates
that defy industry standards. Bluecore’s customer experience platform
enables the personalized digital communications based on both

individual behavior and catalog data.

The Bluecore integration with Demandware is a cartridge that enables
customers to fully implement Bluecore technology on their storefront,
which is easily installed on the site via Demandware's cartridge
system. The cartridge automatically deploys Bluecore tracking across
the site. This will collect vast amounts of customer behavioral data,
in addition to capturing live data about the storefront’s product
catalog. The cartridge enables use of the entire Bluecore product

suite, in just a few easy steps.
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2. Component Overview

2.1  Functional Overview

On-site Activity Tracking

The Bluecore cartridge will track the following on-site user
activities:

e On-site search

e View category page

e View product

e Add product(s) to cart
e Purchase

e Opt-in to email marketing

If necessary, additional user activities can also be uploaded outside
of the Demandware cartridge. Contact your Bluecore Customer Success
team for more details.

On-site Product Catalog Tracking

The Bluecore cartridge will track your on-site product catalog in real-
time, enabling use cases such as price change triggers. The list of
product attributes tracked will depend on the cartridge configuration
chosen with your Bluecore Customer Success team.

Customer Attribute Tracking

The Bluecore cartridge will track the following customer attributes:

e FEmail Address: A customer's unique email address.
e Sign-up Date: The date that a customer signed up on your site.

e TLifetime Value: The total value of a customer's transactions.

If necessary, additional customer attributes can also be uploaded
outside of the Demandware cartridge. Contact your Bluecore Customer
Success team for more details.

2.2 Use Cases

Abandonment Messaging

Remarket to users that have taken an on-site action and then abandoned.
Abandonment actions include, but may not be limited to: on-site search,
category browse, product browse, and cart.
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Behavioral Lifecycle Messaging

Remarket to users that have made purchases or have taken other custom
on-site actions, if applicable.

Product Notification Messaging

Remarket to users that have interacted with products, where attributes
of the product (e.g., price) have subsequently changed.

Product Recommendations

Capture the product catalog to power product recommendations in
remarketing messages.

Customer Analytics

Report on customer analytics based on customers' holistic interactions
with the website and remarketing messages.

Audience Segmentation

Segment customers into different marketing groups based on customers'
holistic interactions with the website and remarketing messages.

Predictive Marketing

Build predictive models based on the activities that the customer has
taken on-site.

2.3 Limitations, Constraints

The Bluecore cartridge provides all implementation necessary to support
the full Bluecore solution set. The actual use cases and solutions

available to you are dependent on your Bluecore contract.

2.4  Compatibility

The Bluecore cartridge has been developed and tested against Commerce
Cloud Digital 16.9.

2.5 Privacy, Payment

The only customer profile information collected by the cartridge is
email address. No other personally identifiable information is
collected. No credit card data is parsed or collected.
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3. Implementation Guide

3.1 Setup

3.11 Uploading the cartridge via Demandware Studio

. Open Demandware Studio.

. Click File>Import > General > Existing Files Into Workspace .

. Browse to the int_bluecore directory.

. Click Finish.

. Click OK when prompted to link the cartridge to the sandbox.

g w N

3.1.2 Registering the cartridge in Demandware

1. Navigate to Business Manager: Administration > Sites > Manage Sites > site .

2. Click the Settings tab.

3. In the Cartridges field, add: int_bluecore to the end of the list (separate
cartridges by colons).

Instance Type: = Sandbox/Development 5

Deprecated. The preferred way of configuring HTTP and HTTPS hostnames is by using new features of the site alinses configuration (*Site URLa/Aliases Configuration”). The HTTP/HTTPS hostnames values set in this
saction will ba usad if no hoatnamaea are dafinad by aliases configuration and are intandad only to support an oldar configuration style

HTTP Hostnama:
HTTPS Hostname:
Instance Type: All

Cartridges: app_storefront_controllers:app_storefront_core:int_bluecore

Effective Cartridge Path: modified_app_storefront_controllers:modified_app_storefront_coresint_bluecore:plugin_apple_pay:plugin_f k:plugin_pi _comr :be_api:core

Apply  Reset

4. Click Apply.

3.1.3 Import Custom Site Preferences into Business Manager

1. Log in to the Demandware Business Manager.

2. Navigate to Administration > Site Development > Import & Export.

3. Click Upload.

4. Browse for the BluecoreMeta.xml file contained in the metadata folder.

Administration > Site Development > Import & Export > Step 1 - Select Import File

System Type Extension Import - Select File

Step 1 of 3. Next Step: Validate Import File

The list below shows all uploaded import files. Please select the file that you want to import.

Select Name

BluecoreMeta.xml
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. Click Upload.

. Click the <<Backbutton at the bottom of the page.
. Click Importin the Meta Data section.

Select the BluecoreMeta.xml file.

. Click Next>>.

0. Click Refresh.

1 Click Import.

R = O 00 J o U

3.14 Configure Custom Preferences using the Business Manager

1. Log into the Demandware Business Manager.

2. Select the correct site from the tabs across the top of the page.
Note: Each site on which Bluecore will exist will display.

3. Click Merchant Tools > Site Preferences > Custom Preferences.

Merchant Tools / Site Preferences / Custom Site Preference Groups

I Cancel l Apply to Other Sites I[ Save

Bluecore Configuration ©

[E: v

12 v of2
Sandbox s
Name Value Default Value

Enabled” Yes v No
Enable Bluecore on this instance

Account ID” bluecore_account_id

Bluecore account identifier

4. Fill in the Site Preferences as directed. Parameter values will be
provided by Bluecore during integration. Your Account ID will be
provided by your Customer Success team if you do not already have
it.

5. Click Save.

3.2 Custom Code

Bluecore needs custom code written in both controllers (or pipelines)

and templates. All custom code ultimately does the same thing; inserts
a script tag into the response HTML. The script tag interacts with an

external script the front end pulls in.

We’d prefer to add code to controllers/pipelines, as they are less
likely to change. However, because some controllers/pipelines return
the entire HTML (including the <html> tag), not just a section of it,
we need to insert our script tag into the template rather than in the
respective controller/pipeline to avoid having the script tag fall
outside the html tag. Files like pt_productsearchresult _VARS.isml are
designed for exactly this.
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3.2.1 Templates

templates/default/components/header/header.isml

Add the following line:

<isinclude template="bluecore/snippetinclude”/>

This included Bluecore template tells the site to pull in the Bluecore
Javascript snippet to handle and relay the script payloads we'll be
sending to the front-end. It’s included on
templates/default/components/header/header.isml as we need our script
pulled in on all pages.

templates/search/pt_productsearchresult_VARS/pt_productsearchresult_VARS.isml
Add an isscript tag that calls our track.js's Search function.

<isscript>
require('int_bluecore/cartridge/scripts/track').Search(pdict.ProductSearchResult);
</isscript>

& & £ & %‘ - < 1 [iscontent type="text/html" charset="UTF-8" compact="true"/>
! T <iscomment>
» (= components

¥ (= content 1 This template is intentionally empty.
P> (= csrf

> (=error

¥ (= mail

¥ (= product
¥ (= rendering
» [ resources

The purpose is as a place holder for a template, with the same name 'higher up' in the cartridge path.
) pt_xxx_UI.isml is "injected' into pt_xxx.isml, in the <head> element, to enable custom cartridges to ¢

1 pt_xxx_VARS.isml is 'injected' into pt_xxx.isml, after the footer element (within the <body>, but nea:

1
= 1
¥ (= search 1
» (= components 13 </iscomment>
» [g] nohits 1
@ productgrid 1 ) )
|¢] productgridwrapper 16 <isscript> . . .
17 require('int_bluecore/cartridge/scripts/track').Search(pdict.ProductSearchResult);
[5] productnav . :
14 </isscript>
1

»

»

| 2

> (2] pt_categorylanding

» [2] pt_categorylanding_Ul

> [g] pt_categorylanding_VARS

> @ pt_contentsearchresult

» [5] pt_contentsearchresult_UI

> @ pt_contentsearchresult_VARS

3 E] pt_productsearchresult

B @ pt_productsearchresult_content

> @ pt_productsearchresult_nohits

[ 2 E‘| pt_productsearchresult_Ul

v B pt_productsearchresult_VARS
|=| pt_productsearchresult_VARS

If your implementation does not use this file, please copy this code
into a template that gets pulled into every search result page. If you
have any questions regarding this, see section 4.3 for support.

templates/checkout/cart/pt_cart_VARS/pt_cart_VARS.isml
Add an isscript tag that calls our track.js's ViewCart function.

<isscript>
require('int_bluecore/cartridge/scripts/track').ViewCart(pdict.cart);
</isscript>

templates/account/wishlist/pt_wishlist_VARS/pt_wishlist_VARS.isml
Add an isscript tag that calls our track.js's ViewWishlist function.

<isscript>
require('int_bluecore/cartridge/scripts/track').ViewWishlist();
</isscript>

templates/checkout/pt_orderconfirmation_VARS/pt_orderconfirmation_VARS.isml
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Add an isscript tag that calls our track.js's Checkout function.
<isscript>
require('int_bluecore/cartridge/scripts/track').Checkout(pdict.Order);
</isscript>

3.2.2 Controllers

If your site uses pipelines, skip this section and continue to 3.2.3 Pipelines

controllers/Product.js (view product)

Add the following line to the detail function, after the template is
rendered:

require ('int bluecore/cartridge/scripts/track') .ViewProduct (product) ;

Example:

Shi— function detail() {

58 const Product = app.getModel{'Product');

54 const product = Product.get{params.pid.stringValue);

0d

bl if (product.isVisible(}) {

602 app.getView( ' 'Product', {

b3 product: product,

B4 DefaultVariant: product.getVariationModel().getDefaultVariant(),

65 CurrentOptionModel: product.updateOptionSelection(params),

6b CurrentVariationModel: product.updateVariationSelection(params)

07 B .render(product.getTemplate() || 'product/productdetail’);

bE

69 require('int_bluecore/cartridge/scripts/track').ViewProduct(product);
70 } else {

71 /4 BFIXME Correct would be to set a 484 stotus code but that breaks the page as it utilizes
72 /4 remote includes which the WA won't resclve

73 response.setStatus(418);

74 app.getView().render('error/notfound’);

75 }

]

77 }

This appends a script tag to the HTML response when a user lands on a
Product Detail Page. This function returns just a section of html, so
it's OK to append our script here.

Add the same line, with the condition that the product be a wvariant,
within the variation function after the template is rendered:

if (product.isVariant()){
require('int_bluecore/cartridge/scripts/track’).ViewProduct(product);
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Example:

202= function variation() {

203

204 const Product = app.getModel('Product');

205 const resetAttributes = false;

206 let product = Product.get(params.pid.stringValue);

207

208 let currentVariationModel = product.updateVariationSelection(params);
209 product = product.isVariationGroup() ? product : getSelectedProduct(product);
210

211 if (product.isVisible()) {

212 if (params.source.stringValue === 'bonus') {

213 const Cart = app.getModel('Cart');

214 const bonusDiscountLineltems = Cart.get().getBonusDiscountLineltems();
215 let bonusDiscountLineltem = null;

216

217 for (let i = @; i < bonusDiscountLineltems.length; i++) {

218 if (bonusDiscountLineltems[i].UUID === params.bonusDiscountLineItemUUID.stringValue) {
219 bonusDiscountLineltem = bonusDiscountlLineltems[i];
220 break;

221 }

222 }

223

224 app.getView('Product', {

225 product: product,

226 CurrentVariationModel: currentVariationModel,

227 BonusDiscountLineltem: bonusDiscountLineltem

228 }) .render('product/components/bonusproduct');

229 } else if (params.format.stringValue) {

230 app.getView('Product', {

231 product: product,

232 GetImages: true,

233 resetAttributes: resetAttributes,

234 CurrentVariationModel: currentVariationModel

235 }).render('product/productcontent');

236 } else {

237 app.getView('Product', {

238 product: product,

239 CurrentVariationModel: currentVariationModel

2490 }) .render('product/product');

241 }

242

243 if (product.isVariant()){

244 require('int_bluecore/cartridge/scripts/track').ViewProduct(product);
245 }

246

247

248 } else {

249 // @FIXME Correct would be to set a 484 status code but that breaks the page as it utilizes
250 // remote includes which the WA won't resolve

251 response.setStatus(419);

252 app.getView().render('error/notfound');

253 }

254

255 }

256

This allows us to register viewing behavior on quick views. We only need
to know when the user sees a full variation (i.e., if they've selected
color AND size), which is the reason for the "if" statement.

controllers/Cart.js (add to cart)
Add the following line to the end of the addProduct function:

require ('int bluecore/cartridge/scripts/track') .AddToCart () ;
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Example:

264+~ function addProduct() {
265 var cart = app.getModel('Cart').goc();
26¢ var renderInfo = cart.addProductToCart();
267
268 if (renderInfo.source === 'giftregistry') {
269 app.getView().render('account/giftregistry/refreshgiftregistry');
270 } else if (renderInfo.template === 'checkout/cart/cart') {
271 app.getView('Cart', {
272 Basket: cart
3 }).render(renderInfo.template);

274 } else if (renderInfo.format === 'ajax') {
275 app.getView('Cart', {
276 cart: cart,
277 BonusDiscountLineItem: renderInfo.BonusDiscountlLineItem
278 }).render(renderInfo.template);
279 } else {
'8 response.redirect(URLUtils.url('Cart-Show'));
}

283 require('int_bluecore/cartridge/scripts/track').AddToCart();

controllers/Cart.js (remove from cart)
Add the following line to the submitForm function under the deleteProduct
handler:

require ('int bluecore/cartridge/scripts/track') .RemoveFromCart (formgrou
p.getTriggeredAction () .object) ;

Example:

178 'deleteProduct': function (formgroup) {

179 Transaction.wrap(function ) {

180 cart.removeProductLineItem(formgroup.getTriggeredAction().object);
181 B;

182

183 require('int_bluecore/cartridge/scripts/track').RemoveFromCart(formgroup.getTriggeredAction().object);
184

185 return {

18¢ cart: cart

187 };

188 } ’

controllers/Wishlist.js (add to wishlist)
Add the following line to the addProduct function:

require ('int bluecore/cartridge/scripts/track') .AddToWishlist () ;

Example:

1958 /**
196 * Uses request parameters to add a product.

197 */

198~ function addProduct() {

199 var Product = app.getModel('Product');

200 var product = Product.get(request.httpParameterMap.pid.stringValue);

201 var productOptionModel = product.updateOptionSelection(request.httpParameterMap);

203 var ProductlList = app.getModel('ProductList');
204 var productlList = ProductlList.get();

205 productList.addProduct(product.object, request.httpParameterMap.Quantity.doubleValue || 1, productOptionModel);
206
207 require('int_bluecore/cartridge/scripts/track').AddToWishlist();
208 }
209
3.2.3 Pipelines
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Use the following steps if your site uses pipelines.

Product-Detail Pipeline

Add the script int bluecore/cartridge/scripts/viewProduct.js to the

Product-Detail pipeline between the Product-GetProduct and the
template interaction node.

g Detail

Product-GetProduct

expression Produ...

o—> Om [dynamic]
no

ript (bc_api)
ript File: int_bluecore:viewProduct.js

Ooe—of|Noe—e

|

error

O+———
©]
g product/productdetail
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Product-Variation Pipeline

Add the script int bluecore/cartridge/scripts/viewProduct.js to the
Product-Variation pipeline after fetching the product, and before the
template interaction nodes.

@ Wariation

=3
2 expression CurrentHttpParameterMap.pid.stringValue
: D
=]
» GeiProduct (be_api)

=] O o errorinatfound
error
=]
=]
. UpdateProduciWariationSelections (ba_api]
=]
=]
. UpdateProduciOptionSelections [be_api)
=]

o opression Product. master

O

o

E

Ecript (bd_api)
Ecript Filp: app_starcfrant_corezproduct/GetDefaultVariani.ds

=]
error

=]
=]
. Assign (o _api]

=]
O
I Ecript (bo_api)
» Script File: int_bluecore:viewProduct.js
=]
error
=]
o

oupressian emet... mxpressian CurrentHttpParameterMap.source.stringValue == 'bonus'

=]
QT QT
na
s . I
o o
g productfproduct - Aszign {bc_api] % Cart-GetBaskeot

o O
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Cart-AddProduct Pipeline

Add the script int bluecore/cartridge/scripts/addToCart.js to the Cart-
AddProduct pipeline before the template interaction node.

K cart 2

=
)

Vv

expression empty(CurrentHttpParameterMap....

> 0» Cart-UpdateLineltem

o
no

Cart-Additem

expression Curre... Assign (bc_api)

@ il .. @ —> om util/redirect
no

cript (bc_api)
Skript File: int_bluecore:addToCart.js

B @@

o
——

error

checkout/cart/minicart

H@°“—°‘<
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Cart-Show Pipeline (removeFromCart)

Add the script int bluecore/cartridge/scripts/removeFromCart.js to the
pipeline under submitForm > deleteProduct.

Set ProductLineltem to TriggeredAction.object for the input dictionary.

Hcort X
° o -]
=] o (=] [«
% Cart-Calculate % Cart-Lalculate Cart-Caiculate) % Cart-Calculats
° ° o
l cript (be_api)
i Skript File: int_blugcore:temoveFromCagt.js
[~}
o o (@]
o
"mmmm
°
o o o o
g Cart-ContinueSh... g Login-Logout % Login-Process % Cant-EditLineltem g COShipping
7] properties 52

@ Pipelet Node - Script (bc_api)
Property
» Configuration
¥ Dictionary Input
ProductLineitem

Value

[ TriggeredAction.object

Wishlist-Add Pipeline

Add the script int bluecore/cartridge/scripts/addToWishlist.js to the
Wishlist-Add pipeline before the Wishlist-Show jump node.
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H wishlist 52

Wishlist-FetchWishList

z

..‘—..‘

tions (bc_api)

c
k-

(be_api)

<

AddProdyctToProductList (bc_api)

o+——Qe+——o

bc_api) Assign (bg_api) ac

N

I

ript (bd_api) search
SEript Filg: int_bluecore:addToWishlist.js

T

(]
)

o
I~

=
Kol

|

oe+——Q0

Wishlist-Show

K

3.3 External Interfaces

The Bluecore cartridge automatically handles all communication required
between your storefront and Bluecore via asynchronous Javascript added
to the site. The Javascript is asynchronous and only performs tracking
functions; it does not impact the viewable page content in any way. The
Javascript has no impact on the load times of your site. Optionally,
you may send additional customer and product information to Bluecore
via direct file upload into the Bluecore UI, or automated file feed to
a Bluecore SFTP location. Contact your Customer Success team for more
details.

3.4 Testing

34.1 Testing Setup

For the purposes of testing, please fill out the custom preferences in
section 3.1.4 the following way:
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Merchant Tools / Site Preferences / Custom Site Preference Groups /

Bluecore Configuration

Instance Type
Sandbox =
[a]~
Name Value
Account ID% test_demandware_partner
Bluecore account identifier

Yes

Enabled

Enable Bluecore on this instance

L4

l Cancel

e

l Apply to Other Sites

Default Value

1-2 v | of2

Edit Across Sites

Edit Across Sites

If your account team has provided you with a more specific Account ID,

please use that instead of “test demandware partner”

After enabling,
pulled in on the front end:

(case sensitive).

you should start seeing our Javascript snippet being
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commerce cloud |  Enter Keyword or Item No Q |

NEW ARRIVALS WOMENS MENS ELECTRONICS TOP SELLERS
Womens / Clothing / Tops
SHOP WOMENS Please Select One + 12 4 Showing 1-120f 276 Results ol o o o o o
2 3405
v Clothing
Outht
Tops
D AN
Y
ickets & Coat
ing Red
> & r
> A )
No-Iron Easy Care Sleeveless Sleeveless Blouse. Stripe Button Down Shirt.
Shirt
$65.00 $59.00 $64.00
ok defs R ¢ ¢ Fakatks sk
) Compare ) Compare ) Compare
PN N N
[® ﬂ Elements Memory Audits Console Sources Network Performance  Application  Security 91 : X
<t—<![endifl—

¥ <head>
<!— dwMarker="linclude" dwTemplateTitle="/default/util/modules.isml (app_storefront_core)"
dwTemplateURL="http://localhost:6@606/target=/app_storefront_core/cartridge/templates/default/u
til/modules.isml" —>
<!— dwMarker="linclude" dwTemplateTitle="/default/components/header/htmlhead.isml
(app_storefront_core)"
dwTemplateURL="http://localhost:68686/target=/app_storefront_core/cartridge/templates/default/c
om@onents/header/htmlhead. isml" —>
ta charset="UTF-8">
http-equiv="x-ua-compatible" content="ie=edge">
a name="viewport" content="width=device-width, initial-scale=1">
<script type="text/javascript" async src="http://triggeredmail.appspot.com/tri
test demandware partner.js"></script>
<script src="http://ajax.gooqleapis.com/ajax/libs/webfont/1/webfont.is" type="text/javascript"
async></script>
P <script type='"text/javascript”s..</script>
> <titles.</title>
<link href="/on/demandware.static/Sites-spicey-test-Site/—/default/dwiScafb65/imaqes/
favicon.ico" rel="shortcut icon">
<meta name="description" content=" Shop Women's Shirts. Short and long sleeve, Oxford, smart,

#ext-genad ol

| triggeredmail

ermail.js

‘\O!Z“\ Vi Cancel

If the script is not being pulled in properly,
issue with the steps in 3.1.x,
section 3.2.1 (adding to

Styles Computed Event Listeners >

Fiiter thov .cls +

element.style {

}

body { style.css:1637
background:» none repeat scroll @

0 M#333;

color: MM#333;
font-family: Arial, sans-serif;
font-size: 12px;

}

body { style.css:43
margin:» 0;

body { user agent stylesheet
display: block;

: gt SR

Inherited from htmi#ext-gend4.wi-lato-n...
html { style.css:32

then there has been an

or with the first template step in

templates/default/components/header/header.isml) .

With the external script pulled in,
created and placed on the window.
can now call to help us test:

;|
| ¥

O SIZE

the “triggermail” object gets
There is a method on triggermail we
“triggermail.enable debug()”:

[w ﬂ Elements Memory Audits Console Sources Network Performance  Application
® | top ¥ | | Filter All levels ¥

[Violation] ‘setTimeout' handler took 37Zms

[Viclation] Forced reflow while executing JavaScript took 129ms

[Violation] ‘setTimeout' handler took 98ms

[Violation] Forced reflow while executing JavaScript took 34ms

» triggermail.enable_debug()
undefined

Security :

dwux-15.9.j57w=14:112

dwux-15.9.j57w=14:182
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After calling the method, we’ll start seeing the payloads the cartridge
should be sending to the frontend, as well as the subsequent payloads
sent to Bluecore via the external script.

Now we can start testing the collection of individual events.

3.4.2 Event Testing

Searching:

Upon landing on a category or search page, we should see the data
handed to the frontend via the cartridge, as well as the Bluecore
“search” payload:

=
Charceal Single Pleat Striped Wool Suit | Enter Keyword or ltem No. Q ) Q [ E
—

NEW ARRIVALS WOMENS MENS ELECTRONICS TOP SELLERS

Mens / Clothing / Suits

SHOP MENS Please Sefect One 4 232 E= Showing 1 - 6 of 6 Resulis
v Clothing
Suits
( als
o N
an
3
@ COLOR
Charcoal Single Pleat Striped Charcoal Flat Front Athletic Fit Charcoal Single Pleat Wool Suit
. . . Wool Suit Shadow Striped Wool Suit
. $500.00 $299.99 $500.00 $299.99 $500-00 $209.99
kg g Fkgy b 8 8 4 gy 8 8 8 8 gy
. 1 Compare 1 Compare 1 Compare
[w ﬂ Elements Memory Audits Conscle Sources Network Performance  Application  Security F 4
® | op ¥ | | Filter All levels ¥ 3
cartridge: ¥ {category: "Suits", breadcrumbs: Array{3)} test demandware partner.js:117
¥ breadcrumbs: (3) ["Mens", "Clothing", “Suits"]
category: "Suits"
b __proto__: Object
BLUECORE REQUEST: iest demandware partner.js:32
¥ {event: "search", properties: {u}} itest demandware partner.js:32

event: "search”
¥ properties:
browser: "Chrome"
distinct_id: "15f25f1598c1b4-83132b@6cefcfl-31617c@3-1fadd@-15T2571598d%7a"
event_source: "salesforce_commerce_cloud”
mp_lib: "web"
os: "Mac 05 X"
search_term: "category:"Suits""
token: "test_demandware_partner"
url: "http://bluecore@l-tech-prinr-na®s-dw.demandware. net/s/spicey-test/mens—clothing-suits"
> oto__: Object
_: Object
» [Viclation] Added synchronous DOM mutation listener to a ‘DOMModeInserted’ event. Consider using MutationObserver kwift.CHROME.min.js:1
to make the page more responsive.
» [Viclation] Added synchronous DOM mutation listener to a 'DOMModeInserted' event. Consider using MutationObserver kwift.CHROME.min.js:1
to make the page more responsive.

If the cartridge event is not seen, there is likely an issue including
the <isscript> tag in

templates/search/pt productsearchresult VARS/pt productsearchresult VAR
S.isml
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PDP Page Loads:
Upon landing on a PDP, we should see a larger cartridge payload, as
well as its subsequent “viewed product” Bluecore payload:

ﬂ# N ARRIVALS WOMENS M TOP

Mens | Clothing  Suits | Charcoal Single Pleat Striped Wool Suit

L be ==

FRS
ERS

Charcoal Single Pleat Striped Wool Suit

| 3 8 fawpid

SELECT COLOR

D CHARCOAL

SELECT SIZE

SELECT WIDTH
[w ﬂ Elements Memory Audits Conscle Sources Network Performance  Application  Security X
® | top ¥ | Filter All levels ¥ o
cartridge: test demandware partner.js:117

v {id: "25686364", name: "Charcoal Single Pleat Striped Wool Suit", wrl: "http://bluecoredl-tech-prinr-nad5-dw. demandware.net/s/spicey-test/.
minPrice: 299.99, .}
b attributeVariations: (3) [“eolor", "size"™, “width"]
» breadcrumbs: (3} ["Mens", "Clothing", “Suits"]
category: "Suits"
color: null
id: "25686364"
image: "http://bluecore@l-tech-prinr-na@5-dw. demandware.net/on/demandware. static/-/5ites-apparel-catalog/default/dw5c@9254c/images/ large/
isMaster: true
isProduct: true
isProductSet: false
isVariant: false
maxPrice: 299.99
minPrice: 299.99
name: "Charcoal 5ingle Pleat Striped Wool Suit"
outDf5tock: false
price: 299.99
size: null
url: "http://bluecore@l-tech-prtnr-na@5-dw.demandware.net/s/spicey-test/25686364.htm1"
»variants: (16) [{.}, {.}, {.}, {.}, {-}, &}, 44 43 4G4 4G 403 493 4-F L6H {-3 4WH]

width: null

»__proto__: Object
BLUECORE REQUEST: test demandware partner.js:32
B fevent: "viewed oroduct". properties: {.}} test demandware partner.is:32

If there is an issue seeing these events, it’s likely an issue calling
our track product event within the “detail” section of the Controller
(or pipeline)

Sku Clicks and Quick Views:

Typical demandware sites reuse the “Product-variation” controller (or
pipeline) for both the selection of skus, and quick views. Thus, when
we call our track product event within the “variation” flow, we should
see payloads fire on quick view clicks, as well specific sku clicks
(either within the quick view modal or on PDPs) :

{LINK Integration Documentation} Page 3-20



Z:opucT auick VIEw
Charcoal Single Pleat Striped Wool Suit, Charcoal

(S
®
|

Charcoal Single Pleat Striped Wool
Suit

$299.99

L A L

SELECT COLOR

D CHARCOAL

SELECT SIZE

40

SELECT WIDTH

Short| |Regular| | Long| SHORT

llts

|
s
S

ﬂ Elements Memory Audits Console Sources Metwork Performance  Application  Security :

) | top ¥ | Filter All levels ¥ o

CArLTLUgE: P (CalBegurly: SULLS , UIeauciumnus: Arrayidsf ‘ ]n't'al Search T Y T P Py |

BLUECORE REQUEST: test demandware partner.js:32
» {event: "search", properties: {.}} test demandware partner.js:32

» [Viclation] Added synchronous DOM mutation listener to a 'DOMModelnserted" event. Consider using MutationObserver kwift.CHROME.min.js:1
to make the page more responsive.

[violation] *setTimeout' handler toock 219ms dwux-15.9.j5?v=14:112
[Viclation] Forced reflow while executing JavaScript took 74ms

[Violation] *setTimeout' handler toock 78ms dwux-15.9,js?v=14:182
cartridge: test demandware partner.js:117

{id: "25686364", name: "Charcoal Single Pleat Striped Wool Suid', url: "htip://bluecoredl-tech-prinr-nad5—dw.demandware.net/s/spicey—
test/25686364. html", price: 299.98, minPrice: 299.99, ..} & qu|ck VIeW
BLUECORE REQUEST: test demandware partner.js:32
» {event: "viewed product", properties: {.}} test demandware partner.js:32
cartridge: test demandware partner.js:117

{id: "25686364", skuld: "640188816284", name: "Charcoal Single Pleat Striped Wool Suit", wrl: “http://bluecored@l-tech-prtnr-nads—
dw. demandware. net/s/spicey-test/648188016204 . html", price: 289.89, .}

BELUECORE REQUEST: k s eCfC Sk Select.test demandware partner.js:32
B {event: "viewed_product", properties: {.}} p I u demandware partner.js:32

cartridge: K test demandware partner.js:117
{id: "25686364", skuId: "640185816242", name: "Charcoal Single t Striped Weool Suit™, wrl: “http://bluecoredl-tech-prinr-nads-

bal.f,|::feJ1?.i!.'1c:ll‘rare.nel‘,:"s;’s;:.ice:'y—test;‘ﬁt!éﬂ8!!!3115242..’JtrrJI", price: 299.99, .}
BLUECORE REQUEST: test demandware partner.js:32
» {event: "viewed_product", properties: {.}} test demandware partner.js:32

If there is an issue seeing the quick view, or sku selections (which
trigger only when you select a full variant, i.e. a color, size, and
width), there is likely an issue calling our track product event within
the “variation” flow, or the site does not use the out-of-the-box
Product-Variation flow.

Add to Cart:
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[ =] - .
commerce cloud | Enter Keyword or Item No. Q ) 9 & -ﬁ

YOUR CART
NEW ARRIVALS WOMENS MENS ELECTRONICS TOP SEU
1% Gharcoal Single Pleat
Mens | Clothing ' Sulls | Charcoal Single Pleat Striped Wool Suit Striped Wool Suil
Coler Charcoal
- Size 40
H Width L
Charcoal Single Pleat Sti Gty 1 $268.99

4 harcoal Single Pleat Striped Wool Sui
$29999 éolor éﬁamogl o o

Size 40
Width Short
SELECT COLOR Qty: 1$299.99
D CHARCOAL Order Subtotal $599.98

or Go Straight to Checkout »

8 40
SELECT WIDTH
Long| LONG
[ ﬂ Elements Memory Audits Console Sources Network Performance  Application  Security :
® top ¥ | | Filter All levels ¥
{id: "25686364", skuld: "640188816242", name: "Charcoal Single Pleat Striped Wool Suit", wrl: “http://bluecoredl-tech-prtnr-nad5s-
dw.demandware.net/s/spicey-test/648188016242 . html", price: 299.89, .}
BLUECORE REQUEST: test demandware partner.is:32
» {event: "viewed_product", properties: {.}} test demandware partner.js:32

b [Violation] Added synchronous DOM mutation listener to a "DOMModeInserted' event. Consider uslng ationObserver kwift.CHROME.min.js:1
to make the page more responsive.

» [Violation] Added synchronous DOM mutation listener to a "DOMNodeInserted' event. Consider using Hutatlonoh&t@w Skjﬂ.CHRUHE.mm.]s.
to make the page more responsive.

[Violation] ‘setTimeout' handler took 188ms dwux—15.9.js7v=14:112
[Violation] Forced reflow while executing JavaScript took 31lms

[Violation] 'setTimeout' handler took 64ms dwux—15.9.is57w=14:182
cartridge: W {id: "25686364", skuld: "648188816242"} test demandware partner.js:137
BLUECORE REQUEST: test demandware partner.js:32
¥ {event: “add_to_cart", properties: {.}} Cart Sku test demandware partner.js:32
cartridge: test demandware partner.js:117

{id: "25686364", skuld: "640188816471", name: “"Charcoal Single B
>
2

dw. demandware. net/s/spicey—test/648188016471 . html", price,
BLUECORE REQUEST:

» {event: "viewed_product", properties: {.}}

Striped Wool Suit", url: “http://bluecoredl-tech-prinr—-nads—
-}

test demandware partner.js:32
test demandware partner.js:32

cartridge: W {id: "25686364", skuld: "6481588016471"} test demandware partner.js:137
BLUECORE REQUEST: test demandware partner.is:32
b {event: "add_to_cart", properties: {.}} test demandware partner.js:32

If cartridge events are not being displayed, there was likely an error
in adding our addToCart functionality to the Cart controller/pipeline
“addProduct” flow.

View Cart
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commerce cloud | Enter Keyword or Item No.

Q) ? & ¥

NEW ARRIVALS WOMENS MENS ELECTRONICS

« Continue Shopping

TOP SELLERS

DELIVERY
PRODUCT OPTIONS ary PRICE TOTAL
Charcoal Single Pleat Striped Wool Suif Home Delivery In Stock $500.00 $299.99 $209.99
Item No.: 640188016426 Remove
Color Charcoal iahli
Size 48 Add to Wishlist
Width Regular
Edit Details
Enter coupon code | m Update Cart Subtotal $299.99
Shipping -
Sales Tax -
Estimated Total $299.99
« Continue Shopping CHECKOUT
[w ﬂ Elements Memory Audits Console Sources Network Performance  Application  Security I 4
® | top ¥ | | Filter All levels ¥ -3

to make the page more responsive.

cartridge: ¥ {productIds: Array(1l}}
¥ productIds: Arrayil)
> @: {id: "25686364", skuld: "64@188016426"}
length: 1
b __proto__: Array(@)
B __proto__: Object
BLUECORE REQUEST:

¥ {event: "viewed_cart", properties: {.}}
event: “"wiewed_cart™
¥ properties:

browser: "Chrome"
distinct_id: "15f25f159Bc1b4-23132b86cefcfl-31617c83-1Ta40@-15f25F15084097a"
email: "test@test.com"
event_source: "salesforce_commerce_cloud”
mp_lib: "web"
o0s5: "Mac 05 X"

F products: [{.}]
token: "test_demandware_partner"

test demandware partner.js:117

test demandware partner.js:32
test demandware partner.js:32

url: "https://bluecoredl-tech-prtnr-na@5-dw.demandware. net/on/demandware.store/Sites-bimmel-test-S5ite/default/Cart-Show"

»__proto__: Object
B __proto__: Object

[Viclationl ‘setTimeout' handler took 158ms

dwux—15.9.17s57v=14:112

This event is a result of adding the ViewCart function call to
templates/checkout/cart/pt cart VARS/pt cart VARS.isml in section

3.2.1.

Remove from Cart
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s ﬂ Elements Memory Audits Console Sources Network Performance  Application  Security :
o | twop ¥ | Filter All levels ¥
» [Violation] Added synchronous DOM mutation listenmer to a 'DOMNodelnserted' event. Consider using MutationObserver kwift.CHROME.min.js:1

to make the page more responsive.
» [Violation] Added synchronous DOM mutation listemer to a ‘DOMNodeInserted’ event. Consider using MutationObserver kwift.CHROME.min.js:1
to make the page more responsive.
cartridge: ¥ {id: "25686364", skuld: “648188016426"} test demandware partner.js:117
id: "256B6364"
skuld: "640188816426"
» _ _proto__: Object
BLUECORE REQUEST: test demandware partner.js:32

test demandware partner.js:32

¥ {event: "remove_from_cart", properties: {.}}
event: "remove_from_cart™

X
=

P properties: {os: "Mac 05 X", browser: "Chrome”, mp_lib: "web", distinct_id: "15f2571598c1b4-@3132b@6cefcfl-31617c@3-1Ta40@-15T2571598d97a"

»__proto__: Object

cartridge: W {productIds: Array(@}} test demandware partner.js:117
[Violation] ‘setTimeout' handler took 12Zms dwux-15.9, js?v=14:112

[Vielation] Forced reflow while executing JavaScript took 43ms
[Violation] ‘setTimeout' handler took 78ms dwux—15.9,j5?v=14:182
This event corresponds to adding the RemoveFromCart functionality in

3.2.2 / 3.2.3.

Wishlist

QI REwI2IRIED

Create Registry e n ﬂ @ G 00

Search Registries

Modify Registries
Charcoal Single Pleat Striped Wool Suit In Stock
SHOP CONFIDENTLY ltermn No.: 640188016341 Date Added Oct 16, 2017
; : Color Charcoal . .
Privacy Policy Size 38 Quantity Desired -
5 Sh . Width Regular
Seure shopping Price £500.99 $299.99 priorty [ Nene ¢
Edit Details N
Update | Remove
Add to Cart
NEED HELP?
If you have any question
[w ﬂ Elements Memory Audits Conscle Sources Network Performance  Application  Security 4
® | top ¥ | | Filter Al levels ¥ o
cartridge: W {id: "25686364", skuld: "648188016341"} test demandware partner.js:117
id: "25686364"
skuld: "548188016341"
B _ _proto__: Object
BLUECORE REQUEST: iest demandware partner.js:32

test demandware partner.js:32
¥ {event: "wishlist", properties: {..}}

event: "wishlist™

» properties: {os: "Mac 0S5 X", browser: "Chrome", mp_lib: "web", distinct_id: "15f25f1598c1b4-83132b@6cefcfl-31617c@3-1fa400-1572571598d97a"

> nrotn @ Ohiect

This event fires only if both the AddToWishlist and ViewWishlist
functions are being called appropriately in 3.2.2 and 3.2.1
respectively.

Checkout
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% commerce cloud | Enter Keyword or ltem No. Q | 9 & E

NEW ARRIVALS WOMENS MENS ELECTRONICS TOP SELLERS

Thank you for your order.

If you have guestions about your order, we're happy to take your call {800-555-0199) Monday - Friday, 8AM - BPM

W) Order Number: 00000901 CREATE ACCOUNT

Crder Placed: Oct 16, 2017 Creating an account is easy. Just fill out
the form below and enjoy the benefits of
PAYMENT METHOD PAYMENT TOTAL being a registered customer.
GIFT CERTIFICATE *****=******LCOJ Amount: $32%.39 Subtotal $299.99 * First Name
BILLING ADDRESS Shipping standard $5.00 steve # ‘
steve spells R .
124 tiv Sales Tax $24.40 « Last Name
e vork Y 10002 Order Total: $329.39
Phone: 2097427601 spells - ‘
SHIPMENT NO. 1 * Email
test@test.com e ‘
SHIPPING STATUS: SHIPPING TO « Confirm Email
Mot Shipped . - onfirm Emai
[w ﬂ Elements Memory Audits Console Sources Network Performance  Application  Security 4
©® | top ¥ | | Filter All levels ¥ o
cartridge: test demandware partner.is:117

¥ {orderId: "@80884581", orderTotalNet: 299.99, orderTotalGross: 323.99, email: "test@test.com”, productlds: Array(l)}
email: "test@test.com"
orderId: "@ae245a1"
orderTotalGross: 323.99
orderTotaliNet: 299,99
¥ productIds: Array{1)
»0: {id: "256B6395", skuld: "64@188@1714@"}

length: 1
»__oroto__: Array(@d)
®__proto__: Object
BLUECORE REQUEST: test demandware partner.js:32

test demandware partner.js:32

¥ {event: "purchase", properties: {..}}
event: "purchase”™
» properties: {os: "Mac 05 X", browser: "Chrome", mp_lib: "web", distinct_id: "15f25f159B8c1b4-83132b@6cefcfl-31617c83-1Ta4@8-1572571508d%7a"
#__proto__: Object
» [Viclation] Added synchronous DOM mutation listenmer to a 'DOMNodelnserted' event. Consider using MutationObserver kwift.CHROME.min.js:1
to make the page more responsive.

e Mintatinn] Addnd e e MM mudmtine 1irtnmar $a = INAMMAAdnTncmrtnd! ;fonnd  Fancddae e dine Bodaddanfibeamne boodf4 FURAME min $-.4

This event corresponds to the Checkout functionality added in 3.2.1.

343 Notes on Testing

- If Cartridge payloads are being logged, but Bluecore Requests
are not, please contact the support team in 4.3, as this is
most likely an issue of handling the payload the demandware
cartridge has handed off, which is something that can be
resolved within the external script pulled in.

- When QA’ing viewed product events, you may see 2 Bluecore
events fired: the “viewed product” event as well as a “patch”.
The patch event fires only a small percentage of the time (1%
by default) to help keep the Bluecore catalog up to date.

- When QA’ing, you may also see “identify” events, which are
handled purely by the external Javascript. Those do not need
to be QA’d.
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4. Operations, Maintenance

4.1 Data Storage

The Bluecore cartridge does not store any data within Demandware. All
data tracked and collected by the cartridge is stored by Bluecore at
its secure data centers.

4.2 Availability

The availability of the cartridge itself is expected to be 100%. The
availability of the tracking interfaces and APIs that the cartridge
communicates with is dependent on your Bluecore Master Services
Agreement or Statement of Work. Please contact to your Bluecore
Customer Success team for further details.

4.3 Support

Bluecore has several support resources:

1. For product documentation, visit support.bluecore.com.

2. For further help, please contact support@bluecore.com and a

Product Specialist will assist you. Product Specialists are
available Monday through Friday, 9:00 AM to 6:00 PM Eastern
Standard Time (excluding US holidays).

3. Depending on your Bluecore Master Services Agreement or Statement
of Work, you may also have a dedicated Bluecore Customer Success
team for general day-to-day support.
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5. User Guide

5.1 Roles, Responsibilities

No recurring tasks or responsibilities are required after initial
implementation of the Bluecore cartridge.

5.2  Storefront Functionality

The Bluecore cartridge does not add any new storefront functionality.
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6. Known Issues

N/A
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7. Release History

Version Date Changes
16.1.0 i Oct. 5, Initial release
2016
16.2.0 { Oct. 11, = Updated documentation
2017
= Fetch category from master when parsing a
variant
= Allow variants products to include

attributevariation parsing

= Provide fallback support to product images
options

= Convert tabs to spaces

= Pull out category fallback logic into own
function

= Update parsedProducts to fetch peer variants
on variant PDPs

= Convert tabs to spaces

= Update viewProduct to support Product input
in pipeline

= Update custom attribute fetching on root
parsed product
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